
 
 
 
 

Department of Veterans Affairs 
National Online Information Sharing 

Training Examples 
 

 

Manager — Analyst 



 NOIS — Training Examples — Manager/Analyst 1 

Department of Veterans Affairs — VistA — August 1998 

Introduction — Manager/Analyst 
 
These training examples represent common tasks performed by NOIS Specialists that 
review the NOIS database for indicators and trends. For NOIS on Forum, this includes 
those who analyze, triage, and review reported problems. This would also include team 
and project managers in Customer Service and Technical Service. For NOIS installed at a 
local site, this would apply to the Chief or IRM or someone doing periodic reviews of 
NOIS calls. 
 
As a NOIS Specialist you can edit calls. You can close and cancel any call, You can 
assign a support open status on calls requiring more background. You can also make 
notes, batch edit, associate calls as duplicates, and create and edit web pages. You can 
use User Defaults (using List Manager to edit your defaults). You can also do anything a 
general user of NOIS can do (which is actually a whole bunch of stuff). If you need help 
with NOIS, contact a NOIS Coordinator. To see who is a NOIS Coordinator, use the 
NOIS menu on Forum for File Setup, enter SPEC and sort by NOIS Coordinator. 
 
The examples here all relate to using the GUI. The only things you can't do with the GUI 
are User Defaults, Define a List, and File Setup. 
 

Benefits 
 
The benefit of NOIS is that you can track and organize reported problems. You can show 
accountability of problems solved and those that are not processed in a timely fashion. 
You can find what was done by looking at status histories and audit trails. NOIS allows 
you to communicate by leaving notes on calls so that NOIS specialists will not forget to 
deal with overdue problems. It provides additional information related to the request such 
as information on software, patches, installations, and contacts. It allows you to work in a 
geographically distributed team organization. Hopefully it provides a better product and 
better service to the customer. 
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Common Lists 
 
Look at the File menu, Most Recently Used menu; these are the last lists that you've 
used. If you haven't used the lists below, look them up. Use File menu, Select List to get 
the Select NOIS List form. Make sure Common is selected, and choose a list. You may 
have to enter a Specific entry. Experiment restricting your list entries. Notice how your 
Most Recently Used menu changes. 
 
Calls for a package: 
These lists are for referred calls for a package or module/version#. 

Package: <package> 
Package, Referred: : <package> 
Module/#:< module/version#> 
Module/#, Referred: < module/version#> 
 

Lists by Specialist or Referral Specialist: 
These lists are useful on calls where a referral specialist is assigned the call. You need to 
enter a specialist (usually yourself). 

Specialist, Open: <specialist> 
Specialist: : <specialist> 
Ref Specialist, Not Closed: <specialist> 
Ref Specialist: : <specialist> 
 

Team Lists and Developing Office: 
There are lists for support teams (these are groups of packages): C1, C2, DSM, 
Exchange, FM, Imaging, MCM, MISS, Oper, PIM, Tech, Tele. Examples for the Clin 2 
team: 

C2-New, C2-Open, C2-, C2-Refer 
You can also use these lists and enter a package group. 

Package Group, Open: <package group> 
Package Group: : <package group> 
Package Group, Refer: : <package group> 
 

These list are useful for looking at all calls for a package or all calls developed at an 
office (CIOFO). 

Ciofo, Dev Open: <office> 
Ciofo, Dev Referred: <office> 
Ciofo, Dev: <office> 
 

Other lists: 
VISN: <visn#>   all calls from a VISN 
Site: <location>   all calls from this site 
Site, Not Closed: <location>  all unresolved calls from this site 
Status: <status>   all calls having this status 
Status (ref): <referral status>  all calls having this referral status 



 NOIS — Training Examples — Manager/Analyst 3 

Department of Veterans Affairs — VistA — August 1998 

Editing Calls 
 
1. Make a Note 

Select the call you want to edit. Use Edit menu, Make a Note to bring up the Make a 
Note form. Enter some text. Paste in a common response (use your right mouse 
button). Note: if you don't have any common responses defined — cancel the Make a 
Note form and use the Options menu, Define Responses to add a common response 
— then make a new note and paste your response. 

 
2. Edit Personal Fields 

Select the call you want to edit. Use Edit menu, Edit Personal Fields to bring up the 
Edit Personal Fields form (you can also Edit Call form). Make some entries and click 
the Save button 

 
3. Batch Edit some calls 

Use Edit menu, Batch Editor to bring up the Batch Editor form). Make some entries 
and click the Save button. You are now presented with the Apply Batch Edits form. 
Review the edit information you have made and select the calls you will apply the 
edits to. Click the Apply button to make the changes or click Cancel to go back to the 
Batch Editor. 
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Reviewing Calls 
 
1. Select a list of calls (restrict it to 5 entries) 

Use File menu, Select List. Select a list. Under Restrictions, select Last # of calls 
and enter 5. Click OK. 

 
2. Display all the calls in Detailed format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Detailed. Click OK. 

 
3. Display all calls in Brief format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Brief. Click OK. 

 
4. Display a Fields format on all calls for the fields Module and Location 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Fields. Clear the fields in display by clicking the << button. Select the 
field Module/Version and click the > button (you could also just double click). Select 
the field Location also. Click OK. 

 
5. Display a Table format on all calls using a selected format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Table. Under Format, select Public and choose a format from the drop-
down list. Click OK. 

 
6. Display a Statistics format on all calls for Module and Location 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Statistics. Select fields (as described in #4). Click OK. 

 
7. Display the same Statistics format and collate by Module 

Use same instructions as #6, except also select Module/Version from the Collate by 
drop-down list. 

 
8. Save a personal format that has fields and use it to display all calls in a Fields 

format 
Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Table. Clear the fields in the display by clicking the << button. Select 
the fields you would frequently use. Order the fields using the v or ^ buttons. Click 
the Define button and type in a name for this format. Click the New button. Now, 
under Formats when select Personal, you can make this selection. Click OK 

 
9. Change back to a standard format 

Use Format menu, Standard Format. The display goes back to a detailed format on 
a single call. 

 
10. Sort calls on the list by site by clicking the list header 
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Click a title on the current list. The list is sorted by that category. Click it again. The 
list is sorted in reverse order. Click the first, untitled section — this is sorted by date 
received (the default). 

 
11. Sort the list by Site, Status, and Priority 

Use Tools menu, Sort List to bring up the Sort Call form. Select fields on how you 
want the list sorted. Click OK. 

 
12. Look at the Graph format 

Select a list with multiple calls on it. Use Format menu, Graph to bring up the graph 
display. Change the fields, change the style, change the options. Experiment. If you 
are on a bar chart, you can zoom the display by dragging from left to right to generate 
the window you want enlarged. To unzoom the graph, drag from right to left and 
upward, or make a new selection of field or style. When you are done looking at 
graphs, Use Format menu, Graph to toggle off the display. You can also select a call 
on the list; the display will return to a standard format. 
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Finding Calls 
 
1. Look up a call 

Use File menu, Select Call to bring up the Select NOIS Call form. If you know the 
last 5 numbers of the call (example: 50001), enter those and click the Submit button. 
You can then select the call from those found. If you know the entire call ID 
(example: SLC-0798-52604), enter it and click Submit. If you know the location 
abbreviation and approximate date the call was opened, enter the abbreviation - 
month and year (example: TUA-0798), then select from the list. Click OK for the 
selection. 

 
2. Add this call to your Temp list 

Use File menu, Save List As to bring up the Save NOIS Calls to a Storage List form. 
Note: if you don't have a personal storage list you will be prompted to create one. If 
you have multiple storage lists you can select them from the drop-down list. Select 
Add calls to list and click OK. Look at your Most Recently Used lists under the File 
menu. 

 
3. Find text using Text Finder 

Use Tools menu, Text Finder to bring up the Text Finder form. Select Last number 
of calls and enter 500. Enter the text you want to find in the calls (example: 
undefined) Click OK. Examine some of the calls to make sure they contain the text. 

 
4. Use queries to find calls. Save the list 

Use File menu, Clear List to start fresh. Use Tools menu, Query to bring up the 
Query form. Enter in the Field box: Module and <enter>. Enter in the 
Module/Version box: TIU and <enter>. Click the And selection. Enter in the Field 
box: Location <enter> and in the Location box: West Palm Beach <enter>. Click OK. 
Use File menu, Save List As to save this list (use Replace this list with these calls) 
and click OK 

 
5. Use graphs to find the selections 

Use Format menu, Graph to turn on the graph display. Select Status from the Fields 
list. Select a Pie style. With your cursor over the closed calls, do a right click. Select 
the menu item: Select where Status = Closed. Notice your list has changed to only the 
closed calls. Refresh the list by selecting Refresh List from the File menu (or use F5). 
Select a call in the list to turn off the graph display. 
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6. Sort the list and use selected calls to find calls 
Click Status on the list header. Use Tools menu, Select from List and select the 
Selected Calls tab. Highlight (drag over) the closed calls. Click OK. You now have 
the closed calls. Refresh the list (F5). 

 
7. Use a query to select calls 

Use Tools menu, Select from List and select the Query tab. Type in Status <enter> 
in the Field box. Type in Closed <enter> in the Status box. Click OK. Same results. 
Refresh the list (F5). 

 
8. Select calls using the list of STATUS: CLOSED. Refresh the list 

Use Tools menu, Select from List and select the Lists tab. Type in Status <enter> in 
the List box. Type in Closed <enter> in the Status box. Click the Include List button 
(or <enter>). Click OK. Same results. Refresh the list (F5). 

 
9. Use graphs and select multiple Specialists 

Use Format menu, Graph to turn on the graph display. Select Specialist from the 
Fields list. Select a Pie style. With your cursor over a section of the pie, do a right 
click. Select the menu item: Add to multiples where Specialist = <somebody>. Click 
over another section, adding other specialists to your selections. You can review your 
selections using the View Multiples action. Now use Select Multiple Specialist. Your 
list is now only those selections. 

 
10. Organize calls in your temp lists 

Select your list of recent alerts (File menu, Select List, select MRA:, and enter your 
name). Use Tools menu, List Organizer to bring up the List Organizer form. Click 
the right mouse button in the Storage Lists section. Select New List. Click on the list. 
Create a few more lists. Move calls between your current lists and your storage lists. 
Experiment. Use the right mouse button actions to rename a list, delete a list, view the 
call. Save your changes. Select one of your temp lists (File menu, Select List, select 
Owned, select the list). Use the Batch Editor to apply a entry for Personal Short Text 
to the calls.  
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Other Stuff 
 
1. Alert someone 

Use Tools menu, Notifications to bring up the Notifications form. Select the Notify 
tab. Select Alert. Select any calls you want to send with the alert. Select users you 
want the alert to go to by selecting them from the Users box. You must click on the 
user so that they appear in the Send to list. Include yourself to see how alerts work 
(and to do #3). Note: You can remove a user from this list by double clicking. Type 
in the Subject of notification. Click OK. 

 
2. Send NOIS calls in a mail message 

This is very similar to #1, except instead of sending an alert, select Mail. Include the 
calls in the mail message. You can also include the display (this may be a detailed 
format of a single call or all calls in a field or other format).You can click the Edit 
Mail Message button to include any message to go along with the call information. 

 
3. Export to a Spreadsheet 

Format the calls in the list with a table format (Format menu, Change Format, all 
calls, table format, select the fields you want). Use File menu, Export, select Table to 
Spreadsheet. Microsoft Excel will be launched and the data in the table will be 
exported automatically to the spreadsheet. 

 
4. Use a Pivot table in a Spreadsheet 

Use the Help menu, Search for Help On, click the Index tab. Enter in Export to a 
word processor or spreadsheet. Print out this example and use it to get a feel for how 
pivot tables work. NOIS data provides a good example for using this technique. 
Select a list of calls and use a table format on items you want to evaluate or use an 
example similar to Workload Review (also in the help file). 

 
5. Examine an Audit Trail on a call 

Select the current call. Use View menu, Other Information and select Status 
History/Audits. The information  
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Tips 
 
Use the field Referral Specialist, Patch, Subcomponents, and Keywords to categorize 
calls within your workgroup. You may want to coordinate this with the Customer Service 
team affiliated with the package. 
 
Use the List Organizer to put problems into a group of the same type of problems. Use 
the Duplicate Editor whenever you can match duplicates. Use Personal Fields to further 
categorize calls that you may want to put into a spreadsheet. Use the Batch Editor to 
assign patch numbers, personal fields, and keywords. 
 
To work with a large list of calls you will need to work in List Manager. The GUI has a 
smaller restriction of calls displayed in a list. 
 

Quiz  
 
1) What list would you use? 

a) You need the referred calls for a package. 
b) You need all calls referred to ep. 
c) You want a sample of the last 500 calls. 

 
2) How would you see a distribution of referred calls for a package by VISN? 
 
3) How would you see a distribution of referred calls for a package by VISN cross 

tabulated by status? 
 
4) For the current call, where do you find out who last edited it and what was changed 
 
5) How do you go back to the calls you were reviewing before you did that selection 

query that found no calls? 
 
6) How would you find out how to use a pivot table with NOIS data? 
 
Answers 
1a. Package, Referred: <package>, 1b. Status (ref): <refer to ep>, 1c. All Calls (restrict it to last 500 calls) 
2. Select Package, Referred: <package> use a Statistic format for VISN, or use a Graph format for VISN. 
3. Select Package, Referred: <package> use a Statistic format for VISN and Status, collate by VISN. 
4. Status History/Audits (on the display toolbar) 
4. Before doing the query, save the list to your temp list. Then you can return to those calls by doing a refresh list (F5). 
5. Lookup Export to a word processor or spreadsheet in the help file. 
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